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An algorithm to implement a boolean function using only NAND's or only NOR's.



 NAND's and NOR's are the most common basic logic circuit element in use because they are simpler to build than AND and OR gates, and because each is  logically complete . Many logical functions are expressed using AND's, OR's, and Inverters (NOT), however, because an implementing circuit can be constructed straightforwardly from the truth table expression of a logical function and because  Karnaugh Map's  can be used to minimize AND, OR, INVERTER networks. 
  This document is adapted, with permission, from algorithms and examples given in  Dr. Jump's Elec326 course notes.  [link] 
 Below a simple algorithm is given for converting a network with AND gates, OR gates and INVERTERS to one with  NAND gates or NOR gates exclusively. First the boolean function is represented using AND's, OR's, and NOT gates. Then, using DeMorgan's Law in various forms, the AND, OR, INVERTER network is converted step-by-step to use only NAND gates or only NOR gates.  
 

Table 1. DeMorgan's Law using Boolean Algebra	 OR to NAND 	 AND to NOR 
	 a∨b≡¬(¬a∧¬b)
          	 a∧b≡¬(¬a∨¬b)
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Figure 1. DeMorgan's Laws Illustrated Using Logic Gates
The figure is adapted with permission from  Dr. Robert Jump's Elec326 lecture notes  [link]. The first two rows of the figure above illustrate DeMorgan's Law using gates. The third row illustrates how to eliminate any inverters with either NAND or NOR gates.

  Conversion Algorithm 
	 Draw AND, OR, INVERTER implementation. First draw out an implementation of the boolean function using AND gates, OR gates and INVERTERS. Any implementation that uses only those three gate types will work. One way to implement a boolean function using AND's, OR's and INVERTERS is to build the   Disjunctive Normal Form  of the boolean function from the truth table that describes the function. Disjunctive Normal Form, is also called   Sum of Products  form.   Propositional Logic: Normal Forms   gives a succinct treatment of normal forms and of how to go from a truth table to Disjunctive Normal Form.

	Apply DeMorgan's Law. Apply DeMorgan's Law to the circuit by using the equivalences in the first two rows of the Figure above. To create a NAND only circuit, use the transforms in the left box, and for a NOR only circuit use the transforms in the right-hand box. 

	Remove redundant inverters: Any time that two inverters are in series (an inverted output goes directly in to an inverted input), remove both of them, since they cancel each other out.

	Replace remaining inverters. Replace any remaining inverters with the equivalent NAND or NOR implementation (the third row of the Figure). 



Example 1. 
 [image: Conversion Example (conversion.png)]

Figure 2. Conversion Example
Example conversion to a NAND only network. 

  

Note that in step c. the final elimination of inverters isn't quite done since B and D are inverted into one of the NAND's. 
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DesignWorks Digital Simulation Software Tutorial



Introduction:



 DesignWorks is a logic schematic creation and
simulation program. It comes with many circuit symbols and models
that allow you to create logical circuits. We will be using
DesignWorks Professional by Capilano Computing.
 For another tutorial, see the Capilano
website: http://www.capilano.com/DWLiteManual/5min.html

Anatomy of a Circuit (some terminology that
may be useful as you read through this doc)



 [image: Circuit Anatomy (Graphic1.png)]

Figure 3.  Circuit Anatomy 
 This figure shows circuit terminology that will be used throughout this tutorial. 


Component Libraries to Use:



 
DesignWorks comes with
libraries of logic components, such as NAND gates, Multiplexors,
and Adders. Because you will be using DesignWorks to understand
basic logic design, you will not need to use the component
libraries that model real components you can buy and use on a
circuit board. Instead, you will be using the components in the
following four libraries : Pseudo Devices.clf, Simulation I0.clf,
Simulation Gates.clf, Simulation Logic.clf.

DesignWorks Do's and Don'ts:



 	Do save your work often.

	Do save intermediate results. If you have a nice working
section of your circuit, save a copy so that you can get back to it
in case anything goes wrong as you add elements. DW is a powerful
piece of software, but does occasionally get into a wiring
snit.

	Do not drag large sections of wired components to move them.
Dragging often causes wires to reattach themselves in undesirable
ways to selected components or things they are dragged over.
Instead what you want to move, cut from the current location, and
paste in the new location.

	If your circuit is behaving strangely,  use the ? tool  to
debug your circuit. Starting with the location of the strange
value, probe connected wiring working from outputs back to inputs.
Test pins and the wires that appear to be connected to them. When
testing pins, the ? tool must be touching the very tip of the pin,
otherwise you will see a Z output. If you find a loose connection,
use the zap tool (see Deleting Wiring below) to delete and reattach
the connection.

	Do test wiring right after it is placed.  (See Testing Wiring
below.)

	Do learn what all the simulation values mean. (See Simulation
values: (0, 1, X, Z, or C) below.)

	Do use named signals  to make connections rather than long
stretches of wiring. When using named signals, spaces are relevant,
so be very careful that the name matches exactly.




DesignWorks Reference Notes:



 	Using Component Libraries:  On the right of the DesignWorks
display, you will see a parts palette. You can select libraries of
components to choose from by selecting the name of the library you
want to use from the library selection drop-down list. You can also
select “ALL LIBRARIES” to be able to choose from all loaded
component libraries. You can load and unload new libraries from the
“File/Libraries” menu.

	  Placing and moving components: Double-click on the component
in the parts palette to the right of the screen. Your cursor will
change into an image of the part. To get out of parts placing mode,
tap the space bar. You can move devices around, by clicking on them
and dragging them to a new position. In order to move a switch type
device, you must select it while holding down the SHIFT key, and
then move it. You can also move components by selecting them, and
then using the arrow keys to move them in discrete intervals. When
moving groups of components, only move in discrete steps or cut and
paste.

	Orienting components:  To orient components so that the output
and input pins face the direction you want, use the arrow keys
while the component is selected, and before you place it. The arrow
keys will flip both the vertical and horizontal orientation of the
component.

	 Wiring:  To create connections, position the pointer near the
endpoint of a pin or wire and drag away toward the other endpoint.
If you hold down the control key it will change the type of routing
to route down and over, rather than over and down. Using the Alt
key while drawing a wire, will create a three segment route. CTL
and ALT can be used together to combine the effects. 

 	  Wiring by Signal Name:  You can connect a named
signal to a pin by selecting the Text Cursor (letter A in the tool
palette), and clicking the pencil at the  end  of the pin. (Clicking
in the middle of the pin creates a pin number). With the end of the
pin selected, place a label that matches the signal name you want
to connect. Note that a physical line will not be drawn in this
case. When using named signals, spaces in front of, within, and
after the name are relevant, so be very careful that the names
match exactly.

	
Testing Wiring:  Once the connection is made,
test the connection by clicking on the signal route and noting the
yellow highlighted path. The highlighted portion should extend all
the way across gate pins (in other words be sure that the pins on
the gate highlight yellow rather than remaining black.) Always test
the connections this way to make sure the exact connection you
intended was made. Signals can appear to be connected, but not
really be making the connection. Sometimes, even a solid yellow
line will turn out not to be connected to the pin. If this happens
you may see X values where you expect 0 or 1. Use the ? tool to
check that the pin and wire have the same value.

	 Adjusting Wiring:  You can adjust line
segments within the connection path by clicking and dragging
anywhere but on a corner.

	Deleting wire segments or entire wire
routes: If you want to delete only a portion of a signal line, use
the “zap” tool. It looks like a lightning bolt. When the zap tool
is selected, it will remove a line segment that it touches, up to
the nearest intersection, device pin, or segment join point.
Selecting a signal and then using the delete key causes the entire
signal route to be removed.




	 Naming things: You can use the text cursor (the letter “A” on
the tool palette at the top of the display) to name components,
signals, and pins on your circuit. Select the “A” and then your
mouse turns into a pencil. Move the pencil to the item you want to
name and select the item. Devices have automatically generated
names that you can modify by selecting them. Signals will bring up
a small box for naming them when you select them while using the
“A”. The auto-generated name will start with SIG. To check that the
thing you have named is really what you intended, select the object
(signal or device). The name will highlight along with the selected
object if it is correctly named. Signal and device names appear in
pink, whereas expository text will appear black.

	 Simulation values:(0, 1, X, Z, or C) During simulation, a
value of “X” denotes a state which cannot be determined. A value of
“Z” denotes a high-impedance state. To turn simulation on, click on
the “running man” icon in the tool bar, (he is to the right of the
“speed” slider.) If you click on a switch to set a value, and
simulation is not turned on, a pop-up box will appear asking if you
want to start simulation. Say yes, of course. A value of “C”
denotes “Conflict” and means that DesignWorks cannot determine the
proper value for a signal because it has been connected to two
sources that are independent of each other; for instance connecting
power to ground. This error often occurs when you have named a
signal in one circuit the same as a signal in another circuit in
the same file. DesignWorks interprets that to mean that the two
signal wires are connected to each other. If that isn't what you
intended, change the name of one of them.

	Showing all values: DesignWorks can display all the signal values in the circuit with small blue numbers. To turn this off, from the Simulation Menu, select "Show Values".

	Printing: You can print directly from DesignWorks using the
File->Print menu. In order to make sure that the design prints
on a single page, you can use Drawing->Sheet Size Wizard.One of
the panes in the wizard will allow you to select Single Printed
Page. You can also save an image file of your circuit using
File->Export->Windows Meta File.




Tutorial:



 We will construct a four-input multiplexor
and test its operation using switches and a hex keyboard. The final
version is shown below and it corresponds to the illustration of a
multiplexor in the text, on p. 61.
 [image: Four-input multiplexor (tutorial_mux.png)]

Figure 4.  Four-input multiplexor 
 Example circuit to construct using Design Works for practice placing elements and wiring them. 

 	Start DesignWorks Professional from the Program menu and
select “new”, then “design”, then “Generic Simulation” from the
file menu.

	To the right, you will see a parts palette. From the library
selection drop-down list, choose “Simulation Gates”.

	Double-click on the 3 input AND gate (AND-3). Your cursor
will change into an AND gate. Place 4 of them vertically on the
paper by left clicking when the device is where you want it. To get
out of “AND-3” mode, tap the space bar. You can move devices
around, by clicking on them and dragging them to a new position.
Pin 1 of all these gates will be the input lines, pin 2 will be the
high order select line, and pin 3 will be the low order select line
(or bit).

	Attach inverters (“NOT”) to the appropriate input pins of
each AND gate. Counting from top to bottom, place inverters on pins
2 and 3 of the first AND, pin 2 of the second AND, and pin 3 of the
third AND.

	Now select the “OR-4” device and place it to the right of all
the AND-3's.

	Wire each of the outputs from the ANDs to the OR-4 circuit.
(See Wiring in the reference section.)

	Connect the signal lines going into pin 2 of each AND gate.
The connection should be such that the signal line goes through any
applicable inverter, after the connection has been made. Similarly,
connect all the signal lines going into pin 3 of each AND gate.
These will be the Select lines.

	From the library selection drop-down list, choose “Simulation
I/O”. Double click on the “Binary Probe” option and hook it up to
the output of your multiplexor. To orient the switch signal so that
the switch connects to the output, use the arrow keys while placing
the component. Notice that the binary probe shows an “X” in its
display. Since the inputs to the circuit have not yet been defined,
the output is “undetermined”.

	Select the “Binary Switch” component and place two of them on
your drawing. Hook one of them to each of the combined input signal
lines into the multiplexor. Those will be the “selector” lines.
Select 4 more binary switches and hook them up to the multiplexor
input lines.

	Naming components of your circuit will help you to remember
their function. Select the writing tool from the tool palette and
name the devices and signals. Name the input signals, A, B, C, and
D, and the AND gates corresponding to the selection of each of
those signals. Name your select lines and output.

	Turn on one of the input lines at a time, and use the
selectors to select that value.

	Having to turn each binary switch on and off individually can
be laborious. Replace the 4 input binary switches with a single HEX
Keyboard. What values of the HEX are convenient for testing the
circuit? Use binary probes on the outputs of the hex if you get
tired of converting in your head to determine which signals are
high.






Chapter 1. Appendices and References



1.1. Propositional Logic: normal forms*



CNF, DNF, … (ENufF already!)



 
In high school algebra, you saw that while
 x3−4x

and
 x(x−2)(x+2)

are equivalent, the second form is particularly useful in
letting you quickly know the roots of the equation.
Similarly, in Boolean algebra 
there are certain canonical  — “normal”  — forms
which have nice properties.

 
A formula in  Conjunctive Normal Form, or  CNF,
is the conjunction of  CNF clauses.
Each clause is a formula of a simple form:
a disjunction of possibly-negated propositions.

Example 1.1. 
 
    c⇒a∧b
    is equivalent to
    (a∨¬c)∧(b∨¬c).
    This latter formula is in CNF, since it is the conjunction of
    disjunctions, and each disjunction consists only of propositions
    and negated propositions.
  


Example 1.2. 
 
    The conjunctions and disjunctions need not be binary.
    The following formula is also is CNF.
  
 
    ¬a∧(a∨b∨¬c)∧(b∨¬d∨e∨f)
  
 
    Note that its first clause is just one negated proposition.
    It is still appropriate to think of this as a disjunction, since
    φ≡φ∨φ.
  


 
Another format,  Disjunctive Normal Form, or  DNF
is the dual of conjunctive normal form.
A DNF formula is the disjunction of  DNF clauses,
each a conjunction of possibly-negated propositions.

Example 1.3. 
 
    a∧b⇒c
    is equivalent to
    ¬a∨¬b∨c
    which is in DNF: three disjunctions,
    each being a clause with only one term.
    (It also happens to be in CNF  — a single clause with three terms!)
    It is also equivalent to the more fleshed out DNF formula
    where we insist that each clause include all three variables.
    We end up with a formula that includes each possible
    clause except
    a∧b∧¬c:
    That is, the formula
    (a∧b∧c)∨(a∧¬b∧c)∨(a∧¬b∧¬c)∨(¬a∧b∧c)∨(¬a∧b∧¬c)∨(¬a∧¬b∧c)∨(¬a∧¬b∧¬c).
  


 
  
Aside

    Electrical Engineering courses, coming from more of a circuit perspective,
    sometimes call
    CNF  product-of-sums,
    and call DNF  sum-of-products,
    based on
    ∨,∧ being
    analogous to
  
    +,*.
  




 
  Any Boolean function can be represented in CNF and in DNF.
  One way to obtain CNF and DNF formulas
  is based upon the truth table for the function.
  
 	
      A DNF formula results from looking at a truth table,
      and focusing on the rows where the function is true:
      As if saying “I'm in this row, or in this row, or …”:
      For each row where the function is true,
      form a conjunction of the propositions.
      (E.g., for the row where a is false,
       and b is true,
       form ¬a∧b.)
      Now, form the disjunction of all those conjunctions.
    

	
      A CNF formula is the pessimistic approach, focusing
      on the rows where the function is false:
      “I'm not in this row, and not in this row, and …”.
      For each row where the function is false, 
      create a formula for “not in this row”:
      (E.g., if in this row a is false and
       b is true
       form ¬(¬a∧b);
       then notice that by DeMorgan's law, this is
       a∨¬b  — a disjunct.
       Now, form the conjunction of all those disjunctions.
    





Example 1.4. 
Table 1.1. Truth table example	a	b	c	Unknown function
	false	false	false	false
	false	false	true	false
	false	true	false	true
	false	true	true	true
	true	false	false	false
	true	false	true	true
	true	true	false	false
	true	true	true	false


 
    For CNF, the false rows give us the following five clauses:
    
 	 a∨b∨c
      

	 a∨b∨¬c
      

	 ¬a∨b∨c
      

	 ¬a∨¬b∨c
      

	 ¬a∨¬b∨¬c
      




    and the full formula is the conjunction of these.
    Essentially, each clause rules out one row as being true.
  
 
    For DNF, the true rows give us the following three clauses:
    
 	 ¬a∧b∧¬c
      

	 ¬a∧b∧c
      

	 a∧¬b∧c
      




    and the full formula is the disjunction of these.
    Essentially, each clause allows one row to be true.
  


 
  This shows that, for any arbitrarily complicated WFF, we
  can find an equivalent WFF in CNF or DNF.  These provide us
  with two very regular and relatively uncomplicated forms to use.

Exercise 1.
 
     
      The above
      example
      produced CNF and DNF formulas for a Boolean function, but
      they are not the simplest such formulas.
      For fun, can you find simpler ones?
    

  

 	
        CNF:
        (a∨b)∧(¬a∨b∨c)∧(¬a∨¬b)
      

	
        DNF:
        (¬a∧b)∨(a∧¬b∧c)
      



 
      

Karnaugh maps


    




Notation for DNF, CNF



 
  Sometimes you'll see the form of CNF and DNF expressed in
  a notation with subscripts. 
  
 	
      DNF is 
      
        ∨i
        ψi
      ,
      
      where each clause
      
        φi
       
      is 
      
        ∧j
        λj
      ,
      where each
      λ
      is a propositional variable (Prop),
      or a negation of one (¬Prop).
    

	
      CNF is
      
         ∧i
         ψi
       ,
       where each clause
       ψi
       is 
       
         ∨j
         λj
       ,
       where each
       λ
       is again a propositional variable (Prop),
       or a negation of one (¬Prop).
    




  For example, in the CNF formula
  (a∨b)∧(¬a∨b∨c)∧(¬a∨¬b)
  we have
  φ2=¬a∨b∨c
  within that clause we have
  λ1=¬a.

 
  One question this notation brings up:
  
 	
      What is the disjunction of a single clause?
      Well, it's reasonable to say that
      ψ≡ψ.
      Note that this is also equivalent to
      ψ∨false.
    

	
      What is the disjunction of zero clauses?
      Well, if we start with
      ψ≡ψ∨false
      and remove the ψ, that leaves us with false!
      Alternately, imagine writing a function which takes a list of booleans,
      and returns the ∨ of all of them  — the natural base case
      for this recursive list-processing program turns out to be false.
      Indeed, this is the accepted definition of the empty disjunction.
      It follows from false being the identity element for ∨.
      Correspondingly, a conjunction of zero clauses is true.
    




  Actually, that subscript notation above isn't quite
  correct: it forces each clause to be the same length, 
  which isn't actually required for CNF or DNF.
  For fun, you can think about how to patch it up.
  (Hint: double-subscripting.)


 
  Note that often one of these forms might be more
  concise than the other.
  Here are two equivalently verbose ways of encoding true,
  in CNF and DNF respectively:
  (a∨¬a)∧(b∨¬b)∧…∧(z∨¬z)
  is equivalent to
  (a∧b∧c∧…∧y∧z)∨(a∧b∧c∧…∧y∧¬z)∨(a∧b∧c∧…∧¬y∧z)∨…∨(¬a∧¬b∧…∧¬y∧¬z).
  The first version corresponds to enumerating the choices for each location
  of a WaterWorld board; it has 26 two-variable clauses.
  This may seem like a lot, but compare it to the second version, which
  corresponds to enumerating all possible
  WaterWorld boards explicitly: it has all possible 26-variable clauses;
  there are
  226
  ≈ 64 billion of them!



1.2. Propositional Equivalences*



 
  The following lists some propositional formula equivalences.
  Remember that we use the symbol ≡ as a relation between two WFFs,
  not as a connective inside a WFF.
  In these, φ, ψ, and θ
  are meta-variables standing for any WFF.

Table 1.2. Propositional Logic Equivalences	 Double Complementation 	
      ¬(¬φ)≡φ
    
	 Complement 	
      φ∨¬φ≡true
    	
      φ∧¬φ≡false
    
	 Identity 	
      φ∨false≡φ
    	
      φ∧true≡φ
    
	 Dominance 	
      φ∨true≡true
    	
      φ∧false≡false
    
	 Idempotency 	
      φ∨φ≡φ
    	
      φ∧φ≡φ
    
	 Absorption 	
      φ∧(φ∨ψ)≡φ
    	
      φ∨φ∧ψ≡φ
    
	 Redundancy 	
      φ∧(¬φ∨ψ)≡φ∧ψ
    	
      φ∨¬φ∧ψ≡φ∨ψ
    
	 DeMorgan's Laws 	
      ¬(φ∧ψ)≡¬φ∨¬ψ
    	
      ¬(φ∨ψ)≡¬φ∧¬ψ
    
	 Associativity 	
      φ∧(ψ∧θ)≡(φ∧ψ)∧θ
    	
      φ∨(ψ∨θ)≡(φ∨ψ)∨θ
    
	 Commutativity 	
      φ∧ψ≡ψ∧φ
    	
      φ∨ψ≡ψ∨φ
    
	 Distributivity	
      φ∧(ψ∨θ)≡φ∧ψ∨φ∧θ
    	
      φ∨ψ∧θ≡(φ∨ψ)∧(φ∨θ)
    


 
  Equivalences for implication are omitted above for brevity and for
  tradition.  They can be derived, using the definition
  a⇒b≡¬a∨b.

Example 1.5. 
 
    For example, using Identity and Commutativity, we have
    true⇒b≡¬true∨b≡false∨b≡b∨false≡b.
  



Solutions
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